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Introduction 

Welcome to a different approach to sound synthesis. With Dopamine, you will find yourself 
approaching your creative process differently — faster and more intuitively than before. 

Dopamine was developed by Big Wave Audio — the same team that created, under the 
drumasonic brand, the Session Guitarist and Session Bassist series for Native Instruments, 
as well as Session Ukulele and Session Percussionist, over the past ten years. 

The motivation behind Dopamine was to create an easy-to-use synth that provides 
production-ready sound textures that go beyond what a typical synthesizer can deliver. 

Dopamine comes loaded with carefully curated presets that get you started right out of the 
box. It contains 223 sound presets, 107 multisamples, 259 modifier presets, 162 arpeggiator 
presets, and 140 MIDI chord progressions — all of which can also be combined, resulting in a 
staggering number of sonic possibilities. 

A unique feature is seamless morphing between two effect settings via the mod wheel, 
enabling dramatic changes in timbre, stereo width, spatial depth, distortion, and brightness 
— all with a single control. 

The most innovative aspect of Dopamine is the 24 sound modifiers. By triggering these 
keyswitches, you can apply real-time sound alterations and transitions that would otherwise 
require complex offline editing and numerous external tools. With Dopamine, you have these 
distinct sound features right at your fingertips. 

 

Setup 

Dopamine is a virtual instrument designed for use with Native Instruments’ industry-standard 
sampler Kontakt and the free Kontakt Player. If you haven't installed either of them yet, 
please visit www.native-instruments.com, search for the free Kontakt Player, and then 
download and install it. 

Next, download the Native Access app from the same site. After installation, open Native 
Access and enter your Dopamine serial number by clicking “+ Add Serial” in the bottom-left 
corner. Then locate the Dopamine library in the “Library” tab at the top and click “Install”. This 
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will download and install Dopamine to the location set under File > Settings > File 
Management > Content Location. 

After installation, launch Kontakt Player — either standalone or as a plug-in in your preferred 
digital audio workstation (DAW) — and locate Dopamine in the Libraries tab. Click it, and the 
list of included presets will refresh on the right-hand side. Double-click the first preset called 
“Dopamine” to load it. 

How to Play Dopamine 

When playing Dopamine on a MIDI keyboard or using MIDI notes in your host DAW, 
distinguish between the following two key ranges: 

 

●​ C0 to B1 triggers 24 sound modifiers, such as pumping effects, tape-stop, and LoFi. 
On an 88-key keyboard, this range starts at the lowest C and extends up two octaves. 
Each modifier key is color-coded. 

●​ Keys from C2 and above play the instrument. 

You can combine these two ranges—for example, using one with your left hand and the other 
with your right—to add real-time modifier effects to your performance. 

Load Sound Presets 

The name of the current sound preset is displayed in the 
top-left corner. These presets apply globally and contain 
settings for the entire instrument. They include 
parameters and on/off states for all tabs: Effects, 
Modifiers, Arpeggiator, and MIDI Chords. 

Click the arrow icons next to the preset name to load the previous or next preset. To mark a 
preset as a favourite, click the star icon. All marked favourites can be filtered in the Preset 
Browser. 

The Preset Browser 

To open the preset browser, click the current preset’s name.  
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​
The Preset Browser, opened by clicking on the current preset’s name 

At the top, you can filter the preset by: 

●​ Selecting a specific genre (e.g., Pop, EDM, etc.) 
●​ Showing only user favourites with the big star icon 
●​ Restricting the content to a specific type, such as Pads, Leads, or Bass. 

All Bass sounds have the “-24” switch on the Sounds page enabled (see Global Controls), 
which transposes the instrument two octaves down. 

Scroll through the list of results and click a preset to audition it directly from your keyboard 
or DAW. Double-click a preset to load it and close the browser. You can also click the check 
icon in the top-right corner to confirm the selected preset or switch directly to one of the 
pages at the bottom of the interface. 

To revert to the sound that was active before opening the browser, click the X icon next to 
the check icon. 

You can mark or unmark presets as favourites using the small star icon next to each preset. 

Lock Parameters 

When you load a sound preset, it updates the settings across all tabs: Sounds, Effects, 
Modifiers, Arpeggiator, and MIDI Chords. 

If you want a specific tab to retain its parameters and on/off state when loading new 
presets, click the small lock icon next to it before switching presets.  
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Sounds 

On the Sounds page, you can adjust the basic parameters that define the sound. At its core, 
Dopamine offers two sound sources — referred to as Source A and Source B — each 
represented by a robotic face on the left and right. 

​
The Main Page / Sounds Page 

Sound Sources 

For each source, you can select a multisample from the 
drop-down menu at the top. Alternatively, drag the number up or 
down, or double-click it to enter a specific value. Use the arrow 
icons to switch to the previous or next multisample in the list. 

Next to the multisample menu, you’ll find a square icon that toggles the corresponding 
Source A or Source B on or off. 

While most samples are looped and can be sustained indefinitely, some samples decay 
quickly and stop after a short time. These samples are labeled with “OS”, indicating “one 
shot.”  
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The volume of each multisample is controlled via the volume fader on each side of 
the Sounds page. 

Below the multisample menu, you’ll find the Amplifier and Filter tabs. Selecting 
either tab displays the corresponding controls underneath. 

Amplifier Parameters 

●​ A, D, S, R: Adjust the volume envelope’s Attack time, Decay 
time, Sustain level, and Release time. Parameters can be 
adjusted by dragging the individual curve points or by using the 
knobs.  

●​ Transpose: Shifts the source sound from -36 to +36 semitones 
(±3 octaves). 

●​ Color: Alters the formants of the selected multisample, 
resulting in a darker or brighter tone.  

●​ Dyn Range: Incoming MIDI velocities affect the source’s volume, ranging from 0 to 
50 dB. 

●​ Vel→Attack: When the attack time is long, Vel→Attack shortens it as MIDI velocity 
increases — higher velocities sound punchier, lower velocities produce a slower 
attack slope. 

Filter Parameters 

●​ Key follow: Below the Filter tab, click the small keyboard icon. 
When enabled, the cutoff frequency follows the pitch you play. 

●​ Filter Type menu: Select between a gentle, soft, punchy, or 
steep filter type. 

●​ A, D, S, R: Adjust the filter envelope’s Attack time, Decay time, 
Sustain level, and Release time. Parameters can be adjusted by 
dragging individual curve points or using the knobs. 

●​ Cutoff: Sets the filter cutoff frequency. 

●​ Resonance: Sets the amount of resonance at the cutoff frequency. The gentle filter 
type does not provide resonance. 

●​ Env Amount: Adjusts how strongly the filter envelope modulates the cutoff. 

●​ Vel→Cutoff: Adjusts how much MIDI velocity scales the filter envelope’s modulation 
of the cutoff. 
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Global Controls 

In the center between the two faces, you’ll find several controls that affect the overall sound. 
From top to bottom, these are: 

●​ Big Circle: The large circle between the robots’ eyes 
intensifies the sound by morphing between the A (left) and 
B (right) settings on the Effects page (see below). This 
knob can also be controlled using the mod wheel on your 
MIDI keyboard. 

●​ Bass: Adds or removes low frequencies. When turned up, a 
parallel signal is sent through a low-pass filter, 
compressed, and extended in sustain. 

●​ Link: When activated, all controls of source A also affect 
the corresponding controls of source B, and vice versa. 

●​ Mono: When monophonic mode is enabled, only one pitch 
can be played at a time. Overlapping notes will glide 
smoothly from the previous pitch to the new pitch. 

●​ Glide: In mono mode, this control adjusts the time it takes 
to glide from one pitch to the next. It has no effect in 
polyphonic mode. 

●​ -24: When enabled, all sounds play two octaves lower, converting normal sounds into 
bass sounds.  

8 



 

Effects 

On the Effects page, you can load up to seven studio effects 
and arrange them by dragging each effect left or right. 
Clicking an effect displays its parameters above, on both the 
left and right sides. Each side (A and B) can be configured 
individually, allowing two different versions of the sound for 
each effect. 

​
The Effects Page 

Morph between Effects Settings A and B 

When you adjust the controls of either side (A or B), the 
big circle in the center fully shifts to the corresponding 
side, reflecting the sound of the side you are editing. 

You can now morph between settings A and B by 
dragging the big circle up or down. This can also be 
controlled via your MIDI keyboard’s mod wheel. 

This allows you to configure sides A and B so that the morphing control can dial in any 
combination of effect parameters, such as reverb amount, filter cutoff, or equalizer 
frequency boost. 

To experience the power of this feature, try it with some of the included sound presets. 
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Change Effects 

To add a new effect to an empty slot, click any of the free slots. This 
opens the FX Browser, where you can load an effect by clicking it. 

To cancel, click the X button in the top-right corner, or clear the slot by 
selecting Clear Slot. 

To change an effect in any slot, click the small magnifying glass 
icon below it. This also opens the FX Browser for that slot. 

To reset the entire effects chain, click the X icon next to the 
rightmost effects slot and select “Delete FX Chain”. 

​
The FX Browser 

Each effect has its own settings, which are generally self-explanatory. Some effects include 
additional settings, displayed below the effect name in the center of the screen. 

Bypass Effects 

Any loaded effect can be bypassed using the square icon next to 
its name, or removed by clicking the X on the opposite side. 

To activate or deactivate the entire effects chain, click the power icon next 
to the Effects tab. Activate the lock icon to keep the effects unchanged 

when loading a different sound preset.​
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Link and Copy Parameters 

To copy effect settings from the left side to the right, click 
the A>B icon, or use B>A to copy from right to left. 

Tip: Hold ALT and click one of these icons to swap the settings of sides A and B. 

When the Link button is activated, all parameters are linked between the left and right sides 
relatively. Note that some parameters, such as Delay Time, are always linked absolutely, 
regardless of whether Link mode is enabled.  
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Modifiers 

On the Modifiers page, you’ll find a list of 24 sound modifiers, represented by 24 keys on a 
labeled keyboard. These powerful tools allow you to apply various real-time effects to any 
sound, either by live triggering or via automatic sequencing. 

​
The Modifiers Page 

Trigger a Modifier Effect 

To trigger one of the 24 modifiers, you can either 

1.​ Click, hold and release its key on the screen using the mouse, or 

2.​ Play it on your MIDI keyboard from C0 to B1, starting at the lowest C on an 88-key 
keyboard. 

Select a Modifier 

When the Follow MIDI icon is enabled, playing a modifier on your MIDI keyboard 
updates the focus to that modifier and displays its parameters above. Alternatively, 
you can select a modifier by clicking it. 

Each modifier has up to four parameters. Some also include an additional drop-down menu 
in the bottom-left corner of the screen, typically for selecting a curve preset (for effects such 
as Pump) or a mode preset (for effects like Tape Stop). The settings for each modifier are 
explained in more detail in Each Modifier Explained. 

12 



 

Auto-Sequence Modifiers 

Above each modifier is a small light bulb icon. When activated by clicking it, the 
modifier can no longer be triggered manually, but is sequenced according to the 16 
steps in the strip above, which can be activated or deactivated individually. 

Each step represents the duration of one eighth note, so the full sequence equals 
two bars in a 4/4 time signature. Each modifier can have its own sequencer steps, 
independent of the others. 

Tip: Hold ALT and click a step to activate or deactivate all 16 steps. 

Tip: Hold ALT and click an active light bulb to deactivate all 24 light bulbs. 

Modifier sequencers run only when the Modifiers power switch is on and the host transport 
is running or notes are being played. When the power switch is off, activated light bulbs turn 
semi-active to indicate their previous state. Clicking a semi-active or inactive light bulb 
automatically turns the Modifiers power switch back on and enables all activated modifier 
sequencers. 

As before, activating the lock icon keeps the modifiers unchanged when loading a new 
sound preset. 

Drag and Drop as MIDI 

To convert the internal modifier sequencers into external MIDI notes 
for further editing, drag and drop the entire sequence from the DRAG 
MIDI field into your host DAW. The Modifiers power switch 
automatically turns off, allowing the generated MIDI notes to trigger 
the modifiers instead of the internal sequencer. 

Load Modifier Presets 

Clicking the modifier preset 
name in the center of the 
screen opens the preset 

menu, organized into categories that describe the main 
characteristics of the included modifier presets. Click a 
category to reveal its sub-menu, then click a preset to 
load it and test it by playing notes on your MIDI 
keyboard. Double-click a preset to load it and close the 
menu. Use the arrows next to the modifier preset name 
to load the previous or next preset. Each modifier preset 
contains parameter settings for all modifier keys. 
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Each Modifier Explained 

The following list briefly explains the function and parameter set of each modifier. Some 
modifiers are assigned to two different keys, but each key’s parameters can be set 
independently. This allows you to create two versions of the same modifier, both accessible 
at your fingertips. 

 

Pump 

Achieve the typical effects usually generated by side-chain compression, or ducking. 

●​ Speed: Select from six different speeds ranging from 2 whole notes 
down to 16th notes. 

●​ Amount: At 100% you will hear the original volume curve. Values 
greater than 100% will amplify the curve, values below 100% will 
dampen it to no effect at 0%. Negative values will invert the curve. 

●​ Shape: The shape control shrinks the length of the selected curve and 
shifts it back (with positive values) or forward (with negative values), 
while stretching the starting value or ending value, respectively. 

●​ Curve Menu: Select a curve preset which will be stretched according to the 
speed control. 

Saw Ramp 

Generate rhythmically timed pulses preceded by a decelerating ramp. 

●​ Ramp Length: Sets the duration of the decelerating ramp from 0 to 8 
eighth notes before the pulse reaches constant speed. 

●​ Depth: At 100% you will hear the pulses’ original volume modification. 
Smaller values will dampen it down to no effect at 0%. 

●​ Shift: With this control, you can shift the timing of the generated 
pulses slightly ahead of or behind the beat. 

●​ Width: Sets the initial stereo width when starting the ramp, where 
100% represents the original. During the ramp phase, the actual stereo width 
is gradually reverted to 100% before reaching the constant speed phase. 

●​ Note values menu: Select a note value ranging from quarter notes down to 
16th sextuplet notes to adjust the pulsation speed of the constant phase. 
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Pump HP 

Create sweeping pump effects by modulating a high pass filter’s cutoff frequency. 

Tip: At low cutoff settings, this is a subtle alternative to “Pump” for carving space for 
the kick without obvious tonal change. At higher cutoff settings, the effect becomes 
more pronounced. 

●​ Curve Menu: Select a curve preset; it will be stretched or compressed 
by the Speed and Shape controls. 

●​ Speed: Select from six different speeds ranging from 2 whole notes 
down to 16th notes. 

●​ Cutoff: Sets the maximum cutoff frequency of the high pass filter. The 
actual cutoff frequency is constantly changing and will be determined 
by the curve you select in the curve menu. 

●​ Resonance: Sets the resonance at the cutoff frequency. Higher values 
make cutoff movement more pronounced. 

●​ Shape: The Shape control shifts the modulation curve’s center left or right: left 
compresses the start and stretches the end; right stretches the start and 
compresses the end. 

Stutter 

Chop your sound up with this modifier in interesting ways. 

●​ Speed: Sets the random duration of mutes between audible snippets. 
●​ Speed Mod: Positive values increase speed over time; negative values 

decrease it. 
●​ Length: Sets the random duration of audible snippets between mutes. 
●​ Random Pan: Controls the amount of random panning applied to each 

snippet. 

Trance Filt 

Apply a rhythmically modulated low-pass filter to the sound.  

●​ Curve Menu: Select a modulation curve, from simple sidechain-style 
modulation to rhythmic patterns. 

●​ Cutoff Min: Sets the cutoff for the minimum value of the modulation 
curve. 

●​ Cutoff Max: Sets the cutoff for the maximum value of the modulation 
curve. 

●​ Resonance: Adjusts the filter resonance. This will make the 
modulation effect more pronounced. 

●​ Shift: Offsets the timing of the built-in curve presets for a laid-back or 
ahead-of-the-beat effect.  
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Tip: You can also swap the Cutoff Min and Max values: Set “Min” to a high value and 
“Max” to a low value to invert the modulation curve.  

Tip: As with all filter-based effects, temporarily raise Resonance while adjusting 
Cutoff to make the effect more audible, then lower it for a subtler result. 

Tip: Lowering “Cutoff Min” below 0 truncates the modulation curve, creating gate-like 
effects. 

Tape Stop 

Modulate the pitch of current notes, inspired by tape braking/acceleration.  

●​ Stop Speed: Sets how quickly the pitch drops from the original pitch to 
the lowest pitch.  

●​ Range: Sets how far the pitch drops.  
●​ Gain: Boost or decrease the gain for a more pronounced or subtle 

effect.  
●​ Restart Speed: Sets how quickly the sound returns to its original pitch 

after releasing the key.  
●​ Mode Menu: Select one of six different operation modes:  

■​ Stop Notes: When releasing the modifier key, all sounding notes will be 
stopped and will not come back. 

■​ Restart: On releasing the modifier key, all sounding notes will restart. If 
held until the pitch drops fully, the note fades out and fades back in 
when the key is released. 

■​ Continuous: The pitch drops and rises without fading notes, similar to 
a pitch bend wheel.  

■​ Stop Notes (Mute), Restart (Mute), Continuous (Mute): These modes 
work like the previous three modes, except that while the effect is 
active, incoming note events will be ignored.  

Tip: Hold Shift while dragging a knob to increase resolution and set exact 
values (e.g., Speed). This works for all knobs. 

Pitch Rise 

Pitch Rise works identically to the Tape Stop effect, but raises the pitch 
instead of lowering it. 

Dark 

Darken, widen and add subtle distortion and movement with this modifier. 

●​ Space: Sets the amount of space/reverb added to the sound. 
●​ Flange: Sets the amount of flanger added to the sound. 
●​ Lowpass: Sets the cutoff frequency of a low-pass filter. 
●​ Saturation: Sets the saturation amount of an added lo-fi effect.  
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Tip: Moving sounds to the background with this effect can help other elements, for 
example main vocals, stand out. 

Space 

Add space and dimension at any point in time by triggering a reverb effect. 

●​ Decay: Sets the decay time of the added reverb. 
●​ Low Shelf: Sets the amount of low frequencies in the reverb signal. 
●​ Damping: Sets the amount of damping of the reverb signal. 
●​ Mix: Blends between the dry and wet signal. 
●​ Mode Menu: With “Mute Input”, this modifier mutes incoming notes 

while pressed. 

Tip: You can use this effect in combination with other effects like Trance Gate, Saw 
Ramp and Pump to chop up the reverb tail.  

Flange 

Thicken your sound or craft special effects with a versatile flanger. 

●​ Rate: Sets the flanger’s modulation rate. 
●​ Amount: Sets the modulation amount. 
●​ Feedback: Sets the flanger’s feedback. 
●​ Mix: Blends between the dry and wet signal. 
●​ Mode Menu: Choose from three different flanger modes. Each of them 

will affect the sound differently. 

Phone 

Switch to a narrow sound known from old telephones. 

●​ Highpass: Sets the low cutoff frequency. 
●​ Lowpass: Sets the high cutoff frequency. 
●​ Distortion: Sets the amount of distortion added to the telephone 

effect. 
●​ Noise: Sets the amount of noise added to the telephone effect. 

Tip: This effect also reduces the stereo width of the signal. You can use it 
solely for this purpose by lowering the high-pass cutoff and raising the 
low-pass cutoff. 

LoFi 

Add grain and crunch by running your sound through a low-quality 8 bit digital 
converter. 

●​ Frequency: Sets the sampling rate of the virtual converter. 
●​ LoFi: Sets the amount of digital jitter. 
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●​ Post Filt: Sets the low pass frequency of a filter applied after the virtual 
conversion. 

●​ Mix: Blends between the original and the processed signal. 

Pitch Dn & Pitch Up 

Instantly Pitch all notes down, or up, by one or two octaves. 

●​ Interval: Choose between a one or two octaves interval. 
●​ Arpeggiator Half Speed / Double Speed: When turned on, the 

arpeggiator will run in half speed or double speed, respectively. It 
will re-sync to the host transport as soon as you trigger or 
release these modifiers, causing the sequencer position to jump. 

Pan Mod 

Modulate the stereo panning with different curves and speeds. 

●​ Speed: Select from six different speeds ranging from 2 whole notes 
down to 16th notes. 

●​ Amount: At 100% you hear the original curve. Above 100% clips the 
envelope for more extreme panning; below 100% reduces modulation 
depth. 

●​ Curve Menu: Choose from various modulation curves; they’ll stretch or 
compress according to the Speed control. 

Octave Trill 

Create octave trills, a typical effect known from old console games. 

●​ Speed: Sets the speed of the trill, either in percent (free run mode), or 
in note values (tempo sync mode). 

●​ Interval: Choose a one- or two-octave interval. 
●​ Mode Menu: Choose between Free Run and Tempo Sync modes. 

Mute All 

Mute all notes and effects, creating breaks without reverb or delay tails 
bleeding into the gap.  
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Arpeggiator 

With the integrated arpeggiator, your played notes can be turned into an automatically 
generated sequence that chops, slices, and rearranges them with new velocities. 

​
The Arpeggiator Page 

To enable the arpeggiator, turn on the 
power switch next to the Arpeggiator tab 

or select an arpeggio from the menu in the center of the screen. 

Load Arpeggiator Presets 

Clicking the arpeggiator preset’s name in the center of 
the screen opens a menu. Select a category to display 
its contents in a sub-menu. Click a preset to load it, or 
double-click to load the preset and close the menu. 
Alternatively, use the left and right arrows next to the 
preset name to load the previous or next preset. 

Note Re-Mapping 

Each arpeggiator preset contains up to eight different pitches, 
visualized as note events in separate lanes. These lanes do not 
represent actual pitches; they are translated into real pitches only 
when you play notes on your MIDI keyboard. 
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For example, if a preset has three lanes—let’s call them “meta 
pitches”—and you play three notes, each meta pitch will 
correspond exactly to a real pitch. If you play more notes than there are meta pitches, some 
real pitches will be grouped to a single meta pitch, occasionally producing two or more notes 
at the same time. Conversely, if you play fewer notes than there are meta pitches, some real 
pitches will be triggered by two or more meta pitches. 

In summary, you can feed any arpeggiator preset with up to eight notes, and it will always 
function correctly, regardless of how many meta pitches the preset contains. 

Arpeggiator Parameters 

Each arpeggiator preset contains 
settings for the parameters 
described below, except for the 
1/2x, 1x, and 2x tempo 
modifications in the top-right 
corner of the screen. If you do 

not want your current settings to be changed, activate the small lock 
icon next to the Arpeggiator tab before loading a preset. 

In the following, each parameter will be described in detail: 

●​ Humanize: Increase this to loosen quantization—note positions become more 
random, mimicking a human feel. 

●​ Swing: Turning this up gradually delays all off-beat note positions. Depending on the 
preset, these off-beats can be based on either an eighth-note or a sixteenth-note grid. 

●​ Length: The original length of each note contained in an arpeggio preset can be 
heard when this knob is set to 100%. With smaller values, the notes are gradually 
shortened. 

Note: In mono mode (see section Global Controls), uninterrupted note transitions 
occur only if the Length parameter is set to 100%. 

●​ Shift: Offsets the timing of the arpeggiated notes for a laid-back or ahead-of-the-beat 
effect. 

●​ 0 / +1 / +2: When this octaving feature is set to +1, notes following 
the highest meta pitch are played one octave higher until the 
highest meta pitch is reached again. At +2, an additional octave is inserted before 
returning to the regular pitch. 

●​ 1/2x / 1x / 2x: Sets the tempo of the arpeggiated notes to half time 
(1/2x), normal time (1x), or double time (2x). Note that this is the 
only parameter not included in the arpeggiator presets.  
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MIDI Chords 

With the integrated MIDI Chords library and player, you can lay the foundation for your 
creative process using inspiring chord progressions. These progressions can be transposed, 
changed in key, and dragged and dropped directly into your DAW project. 

​
The MIDI Chords Page 

Browse and Play MIDI Chords 

Like in the Sound Preset Browser, you can filter all MIDI chords using genre-style tags, from 
Pop to Cinematic. You can also restrict the results to your personal favourites by activating 
the big star icon. To mark a progression as a favourite, click the small star next to its name. 

To play a MIDI chord progression, simply click on it. While playing, its highlight color will 
change from gray to cyan. Click again to stop playback. 

Note: While a MIDI progression is playing, incoming MIDI notes will be ignored. 

Set the Pitch and Key 

In the KEY section, all MIDI progressions can be chromatically transposed from C2 to C4 by 
dragging the pitch label up or down. Each preset was created in either a major or minor key, 
so the key will adjust automatically when you select a different preset. You can still change 
the key manually by clicking the Maj/Min label to toggle between major and minor. 
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Drag and Drop MIDI chords 

After setting the pitch and key, you can drag and drop the current MIDI chord progression 
into your host DAW using the DRAG MIDI field. 

Combine MIDI Chords with the Arpeggiator 

You can also combine the MIDI chords player with the arpeggiator. Simply activate the 
arpeggiator and select a MIDI chords preset to play it. The output of the MIDI chords player 
will then be fed into the arpeggiator. 

Credits 

●​ Product Concept & Design: Samuel Dalferth, Daniel Scholz, Aurid Gjini, Luke 
Batterbury 

●​ UI/UX: S. Dalferth, A. Gjini, D. Scholz 

●​ Graphic Design & Artwork: vstdesigns.com, S. Dalferth, D. Scholz, Marie-Hélène 
Baten 

●​ KSP Scripting: D. Scholz 

●​ Product Management: S. Dalferth 

●​ Sound Presets: S. Dalferth, A. Gjini, L. Batterbury, Marlon Scholz, Leon Hoppe 

●​ Sample Post Production: Peter Scholz, S. Dalferth 

●​ Arpeggios & Chord Progressions: L. Batterbury, M. Scholz, S. Dalferth 

●​ Quality Assurance: S. Dalferth, P. Scholz, D. Scholz, Cris Vogt 

●​ Marketing: Pia Detjen, Klaus Teuschler, S. Dalferth, Robin Thomson, A. Gjini, Xheisi 
Prenga 

●​ Documentation: D. Scholz, S. Dalferth 

●​ Finalization & Encoding: Rembert Gantke 

22 


	 
	 
	Manual 
	 
	Introduction 
	Setup 
	How to Play Dopamine 
	Load Sound Presets 
	The Preset Browser 
	Lock Parameters 

	Sounds 
	Sound Sources 
	Amplifier Parameters 
	Filter Parameters 
	Global Controls 

	Effects 
	Morph between Effects Settings A and B 
	Change Effects 
	Bypass Effects 
	Link and Copy Parameters 

	Modifiers 
	Trigger a Modifier Effect 
	Select a Modifier 
	Auto-Sequence Modifiers 
	Drag and Drop as MIDI 
	Load Modifier Presets 
	Each Modifier Explained 
	Pump 
	Saw Ramp 
	Pump HP 
	Stutter 
	Trance Filt 
	Tape Stop 
	Pitch Rise 
	Dark 
	Space 
	Flange 
	Phone 
	LoFi 
	Pitch Dn & Pitch Up 
	Pan Mod 
	Octave Trill 
	Mute All 


	Arpeggiator 
	Load Arpeggiator Presets 
	Note Re-Mapping 
	Arpeggiator Parameters 

	MIDI Chords 
	Browse and Play MIDI Chords 
	Set the Pitch and Key 
	Drag and Drop MIDI chords 
	Combine MIDI Chords with the Arpeggiator 

	Credits 


